Introduction

Atmel Studio is an integrated development platform from Microchip. It provides a modern and powerful environment for doing AVR® and Arm® development.

Get started by exploring the included example projects. Run your solution on a starter or evaluation kit. Program and debug your project with the included simulator, or use one of the powerful on-chip debugging and programming tools from Microchip. Get productive with the various navigate, refactor and IntelliSense® features in the included editor.

Atmel Studio carries and integrates Atmel START, the GCC toolchains for both AVR and Arm, Atmel Software Framework, AVR Assembler and Simulator. All the newest Microchip tools are supported including Power Debugger, Atmel-ICE, Embedded Debugger, AVR ONE!, JTAGICE mkII, JTAGICE3, STK500, STK600, AVRISP mkII, AVR Dragon, and SAM-ICE™.
# Table of Contents

**Introduction**..................................................................................................................................................... 1

1. **New and Noteworthy**.................................................................................................................................. 3  
   1.1. Atmel Studio 7.0........................................................................................................................... 3  
   1.2. Atmel Studio 6.2 Service Pack 2.................................................................................................. 8  
   1.3. Atmel Studio 6.2 Service Pack 1.................................................................................................. 8  
   1.4. Atmel Studio 6.2........................................................................................................................... 8  
   1.5. Atmel Studio 6.1 Update 2........................................................................................................... 9  
   1.6. Atmel Studio 6.1 Update 1.1........................................................................................................ 9  
   1.7. Atmel Studio 6.1 Update 1........................................................................................................... 9  
   1.8. Atmel Studio 6.1........................................................................................................................... 9  
   1.9. Atmel Studio 6.0........................................................................................................................... 10  
   1.10. AVR Studio 5.1.......................................................................................................................... 10  

2. **Frequently Asked Questions**.................................................................................................................. 11  
   2.1. Compatibility with Legacy AVR Software and Third-party Products........................................ 12  
   2.2. Atmel Studio Interface................................................................................................................ 13  
   2.3. Performance Issues................................................................................................................... 14  
   2.4. Driver and USB Issues............................................................................................................... 14  

3. **Installation**............................................................................................................................................. 18  

4. **Extensions**............................................................................................................................................. 19  

5. **Features and Bugs**.................................................................................................................................. 20  

6. **Device Support**...................................................................................................................................... 27  
   6.1. Device Notes.............................................................................................................................. 27  

7. **Revision History**.................................................................................................................................... 28  

The Microchip Website......................................................................................................................................... 29  

Product Change Notification Service................................................................................................................ 29  

Customer Support........................................................................................................................................... 29  

Microchip Devices Code Protection Feature..................................................................................................... 29  

Legal Notice..................................................................................................................................................... 29  

Trademarks...................................................................................................................................................... 30  

Quality Management System............................................................................................................................ 30  

Worldwide Sales and Service............................................................................................................................ 31
1. **New and Noteworthy**

New features available.

1.1 **Atmel Studio 7.0**

**Atmel Studio 7.0.2389**

Atmel Studio 7.0.2389 contains:

- Advanced Software Framework 3.47.0
- AVR 8-bit GCC Toolchain 3.6.2
- Arm GCC Toolchain 6.3.1 with Upstream Versions: gcc (Arm/embedded-6-branch revision 249437), GNU Arm Embedded Toolchain: 6-2017-q2-update
- Inclusion of the Most Recent Device Family Packs Included in Installer as of Sept. 2019. Use the Device Pack Manager to Check for Updates to get the Newest Device Support, or to Download an Older Device Family Pack for Legacy Support.
- Contains Fixes for the Following Issues:
  - AVRSV-8221: Issue with SRAM access seen for ATtiny817 with EDBG
  - AVRSV-8212: Reading Target voltage for SAMD21 fails
  - AVRSV-8187: Support for CMSIS 5.4.0 schema in atpackmanager
  - AVRSV-8170: SAM D51, E5x - ELF parsing incorrect with ECC in flash
  - AVRSV-8105: Erase User page before programming fails for SAME54
  - AVRSV-8073: SAM E54 User Page read/write using atprogram
  - AVRSV-8130: Studio picks up old JLinkArm.dll instead of the installed one
  - AVRSV-8166: tinyAVR®-2 devices are not compiling due to incorrect memory definition in linker script
  - AVRSV-8176: EEPROM and User Signature erase broken on UPDI
  - AVRSV-8158: Unable to build ASM-projects for AVR64DA128 in Studio
  - AVRSV-8123: Reading voltage doesn't work when device ID does not match
  - AVRSV-8152: Update lib-elf-dwarf build job from stash to bitbucket
  - AVRSV-8132: ChipErase issue with Jlink
  - AVRSV-8131: SAMD21J17D is unable to Program or Debug with Atmel-ICE
  - AVRSV-8171: SAM L11 BOOTOPT programming issue
  - AVRSV-8159: Not able to program BOCOR on SAML11 from within an ELF file
  - AVRSV-8149: Breakpoints support for TrustZone® SG assembly instruction
  - AVRSV-8182: Issue with Secure Boot support for SAM L11

**Atmel Studio 7.0.1931**

Atmel Studio 7.0.1931 contains:

- Advanced Software Framework 3.40.0
- New Microchip Gallery extension
- Atmel START Extension Provides Improved Feedback on Required Device Pack Dependencies
- Support for Arm® Cortex®-M23 Architecture with TrustZone®
- Support for Kits with the New nEDBG Debugger Platform
- Support for Devices:
  - ATSAMHA1E[14|15|16]AB
  - ATSAML10[D][E][14|15|16]A
  - ATSAML11[D][E][14|15|16]A
  - ATtiny202, ATtiny204, ATtiny402, ATtiny404, ATtiny406, ATtiny804, ATtiny806, ATtiny807, ATtiny1604, ATtiny1606, ATtiny1607
- AVR 8-bit GCC Toolchain 3.6.1
Arm GCC Toolchain 6.3.1 with Upstream Versions: gcc (Arm/embedded-6-branch revision 249437), GNU Arm Embedded Toolchain: 6-2017-q2-update

Atmel Studio 7.0.1931 Contains Fixes for the Following Issues that were Present in 7.0.1645:

- AVRSV-8001: Tool firmware upgrade instability.
- AVRSV-8063: ELF production file programming did not support fuses for ATtiny817 family.
- AVRSV-8075: Launch of debugging with ATSAM4L unstable in some cases.
- AVRSV-7895: Solution with links between projects compiles wrong file.
- AVRSV-7745: Linked files in subfolder causes build failure.
- AVRSV-7939: Function breakpoint fails for AVR devices.
- AVRSV-8005: Writing fuses and memory fails in some cases on M0+ devices.

Atmel Studio 7.0.1645
Atmel Studio 7.0.1645 contains:

- Advanced Software Framework 3.35.1.898
- Support for Devices:
  - ATmega4808, ATmega4809
  - ATtiny1614, ATtiny3214, ATtiny3216, ATtiny3217
  - ATSAMC[20|21][J|N][15|17|18]A
  - ATSAMD20[E|G|J][14|15|16]B
  - ATSAMD51[G|J][P][18|19|20]A
  - ATSAME[51|53][S][4][U][N][18|19][20]
  - ATSAME70[N][Q][19|20|21]B
  - ATSAMS70[Q][19|20|21]B
- AVR 8-bit GCC Toolchain 3.6.1
- Arm GCC Toolchain 6.3.1 with Upstream Versions: gcc (Arm/embedded-6-branch revision 249437), GNU Arm Embedded Toolchain: 6-2017-q2-update

Atmel Studio 7.0.1645 Contains Fixes for the Following Issues that were Present in 7.0.1417:

- AVRSV-7798: ATtiny817 fuse programming from ELF issue fixed.
- AVRSV-7742: Compiling an imported Arduino sketch for Arduino zero shows error.
- AVRSV-7903: Studio automatically sets GPNVM bits [7:8] thereby enabling TCM.
- AVRSV-7892: Writing SAML22 RWW flash fails.
- AVRSV-7889: Skewed debug info for AVR 8-bit in AS 7.0.1417.
- AVRSV-7883: Incorrect warning message for KB2978092 during installation of AS 7.0.1417.
- AVRSV-7016: Hex parser fails on UNIX® line endings.
- AVRSV-4914: Add support for new avr-gcc __int24 and __uint24 types.
- AVRSV-7877: Devices with external SRAM fails to calculate available SRAM.
- AVRSV-7845: Crash in __ReallyTerminateAfterLaunchFinished.
- AVRSV-7834: Pack manager fails to download CMSIS DFPs.
- AVRSV-7876: Add checksum fields to http header for KitsDatabase.xml.
- AVRSV-7854: NaN values not handled by atprogram.
- AVRSV-7911: Problems reading device ID on ATmega4809.
- AVRSV-7202: Arduino Library Grouping can have better representation.
- AVRSV-7927: Security Bit Window in Device Programming should not always be available depending on the MCUs.
- AVRSV-7973: Chip erase outside prog session fails on SAM4L.
- AVRSV-7961: FUSE configuration warning for BOD(BODCFG.LVL) is incorrect in Atmel Studio.

Note: QTouch® Composer extension must be updated to version 5.9.122 or later to work with Atmel Studio 7.0.1645.
Atmel Studio 7.0.1417
Atmel Studio 7.0.1417 contains a fix for the following issue that was present in 7.0.1416:
- AVRSV-7827: New WinUSB driver fails to install on 32-bit Windows®

Atmel Studio 7.0.1416
The following changes are done in Atmel Studio 7.0.1416:
- Changed Driver to WinUSB for AVR Dragon, AVRISP mkII, JTAGICE mkII, JTAGICE3, AVR ONE!, STK600, and QT600
- Installer Improvements
- Improved Support for Installing Older Device Family Packs
- AVR 8-bit GCC Toolchain 3.6.0 with Upstream Versions:
  - gcc 5.4.0
  - Binutils 2.26.20160125
  - avr-libc 2.0.0
  - gdb 7.8
- Arm GCC Toolchain 6.2.1 with Upstream Versions:
  - gcc (Arm/embedded-6-branch revision 243739), GNU Arm Embedded Toolchain: 6-2016-q4-major
  - Binutils 2.27
  - gdb 7.12
- Advanced Software Framework 3.34.1

Atmel Studio 7.0.1416 contains a fix for the following issues that were present in 7.0.1188:
- AVRSV-7492: Illegal PC value after a few resume-suspend cycles on SAMD10.
- AVRSV-7486: Debugging may fail in Cortex®-M0+ SAM devices at high clock.
- AVRSV-7693: Go to source from Watch window crashes studio.
- AVRSV-7741: Writing Flash or EEPROM with size of 0x100 or 0x1000 fails on ISP/SPI programming.

Atmel Studio 7.0.1188
The following changes are done in Atmel Studio 7.0.1188:
- Added Support for New AVR8X Architecture
- Installer Improvements
- Improved Arduino Import
- Change How Fuses are Listed in the Programming Dialog
- AVR 8-bit GCC Toolchain 3.5.4 with Upstream Versions:
  - gcc 4.9.2
  - Binutils 2.26
  - avr-libc 2.0.0
  - gdb 7.8

Atmel Studio 7.0.1188 Contains a Fix for the Following Issues that were Present in 7.0.1006:
- AVRSV-7149: When writing EEPROM, bytes that are 0xFF are wrongly skipped.
- AVRSV-7393: Atmel Studio backend crashes when debugging a COFF object file.
- AVRSV-7564: Atmel Studio installation is hanging.
- AVRSV-7580: Atmel Studio not handling DCACHE properly on SAM Cortex®-M7 devices.
- AVRSV-7582: Remove white spaces while saving file does not show the anticipated effect.
- AVRSV-7594: Atmel Studio crashes in some cases when you stop debugging.
- AVRSV-7602: Cannot find bounds of the current function.
- AVRSV-7607: Invalid MTB buffer start address for SAML2x and SAMC2x devices.

Atmel Studio 7.0.1006
The following changes are done in Atmel Studio 7.0.1006:
• New Atmel START Extension That Allows the User to Create and Configure Atmel START Projects within Atmel Studio
• Ability to Load Multiple Modules in a Debug Session (experimental)
• AVR 8-bit GCC Toolchain 3.5.3 with Upstream Versions:
  – gcc 4.9.2
  – Binutils 2.26
  – avr-libc 2.0.0
  – gdb 7.8
• Arm GCC Toolchain 5.3.1 with Upstream Versions:
  – gcc (Arm/embedded-5-branch revision 234589)
  – Binutils 2.26
  – gdb 7.10

Atmel Studio 7.0.1006 Contains a Fix for the Following Issues that were Present in 7.0.943:
• AVRSV-6878: Atmel Studio write the write-once wdt registers on some SAM devices.
• AVRSV-7470: SAM Cortex®-M7 devices fails launch occasionally.
• AVRSV-7471: Devices with external and internal RAM lists all the RAM as available.
• AVRSV-7473: Atmel Studio hangs during start-up.
• AVRSV-7474: Kits connected to Atmel Studio are not getting enumerated in the QTouch Start Page.
• AVRSV-7477: Show all files does not work from solution explorer.
• AVRSV-7482: Exception when adding a breakpoint on SAM4L.
• AVRSV-7486: Debugging may fail in Cortex®-M0+ SAM devices at high clock speeds.

Atmel Studio 7.0.943
Atmel Studio 7.0.943 contains a fix for the following issue:
• AVRSV-7459: Projects containing files with uppercase file names can fail to build. Saving files with uppercase file names convert file names to lower case.

Atmel Studio 7.0.934
The following changes are done in Atmel Studio 7.0.934:
• AVR 8-bit GCC Toolchain 3.5.2 with Upstream Versions:
  – gcc 4.9.2
  – Binutils 2.26
  – avr-libc 2.0.0
  – gdb 7.8
• AVR 32-bit GCC Toolchain 3.4.3 with Upstream Versions:
  – gcc 4.4.7
  – Binutils 2.23.1
  – Newlib 1.16.0
• Arm GCC Toolchain 4.9.3 with Upstream Versions:
  – gcc (Arm/embedded-4_9-branch revision 224288)
  – Binutils 2.24
  – gdb 7.8.0.20150304-cvs

Atmel Studio 7.0.934 resolves the following issues present in Atmel Studio 7.0.790:
• AVRSV-7376: Atmel-ICE slow programming.
• AVRSV-7379: Unhandled exception when writing fuses or lock bits when Auto Read is turned off.
• AVRSV-7396: Some machines shows an error regarding 'Exception in MemoryPressureReliever'.
• AVRSV-7400: When in Standard mode, Disable debugWIRE and Close are not visible in the Debug menu.
• AVRSV-7408: When using Atmel Studio in Standard mode, the Set Startup Project menu is missing.
Atmel Studio 7.0.790
The following features are added in Atmel Studio 7.0.790:
• Support for Mass Storage Mode in Embedded Debugger (EDBG), Enabling Drag and Drop Programming
• Introduction of User Interface Profiles. The User can Choose an Interface Where Some of the Toolbar Buttons and Menu Items are Removed.
• Support for Importing Libraries to Previously Imported Sketches. Added support for Arduino Zero and Zero Pro.
• Parallel Build Turned on by Default

Atmel Studio 7.0.790 resolves the following issues present in Atmel Studio 7.0.634:
• AVRSV-7084: Persist user settings during the upgrade.
• AVRSV-7014: Some ATmega and ATtiny devices failed to start debugging with the Simulator.
• AVRSV-7230: 'Show all files' in Solution Explorer not consistent.
• AVRSV-7062: Firmware upgrade of Xplained Mini kits not detected.
• AVRSV-7164: Reading flash to .bin file created incorrect .bin file.
• AVRSV-7106: Hex files with UNIX or mixed file endings fail to load.
• AVRSV-7126: Data breakpoints for Arm should not be limited to RAM.

Atmel Studio 7.0.634
This release adds device support for the SAM B11 device family.

Atmel Studio 7.0.634 resolves the following issues present in Atmel Studio 7.0.594:
• AVRSV-6873: Jungo Driver issue with Windows 10.
• AVRSV-6676: Launching debugging fails due to an issue with Intel graphics driver.

Atmel Studio 7.0.594
Atmel Studio 7.0.594 resolves the following issues present in Atmel Studio 7.0.582:
• AVRSV-7008: Opening a 6.2 project in Atmel Studio 7.0.582 persists Debug configuration settings for all the other configurations.
• AVRSV-6983: Uninstalling Studio extensions does not work in some cases.
• AVRSV-7018: Project Creation fails with some culture-specific user-names.
• AVRSV-7019: Help Viewer does not work on 32-bit machines.
• Issues with getting tools/debuggers recognized or visible see section 2.4 in 'Atmel Studio 7.0.594-readme.pdf' for workarounds.

Atmel Studio 7.0.582
• Updated to Visual Studio Isolated Shell 2015
• Integration with Atmel START
  – This tool will help you select and configure software components, drivers, middle-ware, and example projects to tailor your embedded application in a usable and optimized manner
• New Device Support System, CMSIS Pack Compliant
• Data Visualizer, Used for Processing and Visualizing Data
• Updated Help System, Improved Context-Sensitive Help
• Advanced Software Framework Version 3.27.3. ASF is an Extensive Software Library of Software Stacks and Examples.
• A Major Upgrade of the Visual Assist Extension to Atmel Studio that Assists with Reading, Writing, Re-Factoring, Navigating Code Fast
• Import Arduino Sketch Projects Into Atmel Studio
• Support for Flip-Compatible Bootloaders in atprogram and Programming Dialogue. The Connected Device Appears as a Tool.
• AVR 8-bit GCC Toolchain 3.5.0 with Upstream Versions:
  – gcc 4.9.2
  – Binutils 2.25
  – avr-libc 1.8.0svn
1.2 **Atmel Studio 6.2 Service Pack 2**

- Advanced Software Framework 3.21.0
- Added support for the SAM L21 device family
- Added support for the SAM V7 device family, based on the Arm Cortex-M7 core

1.3 **Atmel Studio 6.2 Service Pack 1**

- Advanced Software Framework 3.19.0
- AVR 8-bit Toolchain 3.4.5 with upstream versions:
  - GCC 4.8.1
  - Binutils 2.41
  - avr-libc 1.8.0svn
  - gdb 7.8
- AVR 32-bit Toolchain 3.4.2 with upstream versions:
  - GCC 4.4.7
  - Binutils 2.23.1
- Arm GCC Toolchain 4.8.4 with upstream versions:
  - GCC 4.8.4
  - Binutils 2.23.1
  - gdb 7.8
- Support for trace buffers for Arm (MTB) and 32-bit AVR UC3 (NanoTrace)
- Support for attaching to targets

1.4 **Atmel Studio 6.2**

- Advanced Software Framework 3.17.0
- AVR 8-bit Toolchain 3.4.4 (with upstream GCC 4.8.1)
- AVR 32-bit Toolchain 3.4.2 (with upstream GCC 4.4.7)
- Arm GCC Toolchain 4.8.3
- Support for Atmel-ICE
- Support for Xplained Mini
- Support for data breakpoints

---

1 For more information, see the readme that is installed as part of the toolchain.

2 For more information, see the readme that is installed as part of the toolchain.
• Read OSCCAL calibration for tinyAVR® and megaAVR®
• Create ELF production files for AVR 8-bit using the programming dialogue
• Live Watch
• Non-intrusive trace support for SAM3 and SAM4 family of devices including
  – Interrupt trace and monitoring
  – Data trace
  – FreeRTOS™ awareness
  – Statistical code profiling
• Polled Data trace support for Cortex M0+
• Default debugger for SAM devices is now GDB. GDB does in some scenarios handle debugging of optimized code better.
• Support to create a GCC Board project (Microchip board\User board) for ALL the installed versions of ASF
• New ASF Board Wizard, to Add or Remove Board Project Template
• Improved loading time of New Example Project dialog, by loading only one ASF version by default
• IDR events now get displayed in a separate pane in the output window
• LSS file syntax highlighting

1.5 Atmel Studio 6.1 Update 2
• Support for SAM D20 devices on the JTAGICE3
• Advanced Software Framework 3.11.0

1.6 Atmel Studio 6.1 Update 1.1
• Fix programming of boot section for XMEGA® devices introduced in 6.1 update 1
• Fix SAM4LSP32 bare-bone project setup

1.7 Atmel Studio 6.1 Update 1
• Advanced Software Framework 3.9.1
• Extension Development Kit (XDK). Support for packaging an Embedded Application project into an Microchip Gallery Extension.
• Support for SAM D20 and SAM4N devices
• Arm GCC Toolchain 4.7.3 with experimental newlib-nano and multilibs

1.8 Atmel Studio 6.1
• Support for Embedded Debugger platform
• Support for Xplained Pro kits
• Advanced Software Framework 3.8.0
• AVR 8-bit Toolchain 3.4.2 (with upstream GCC 4.7.2)
• AVR 32-bit Toolchain 3.4.2 (with upstream GCC 4.4.7)
• Arm GCC Toolchain 4.7.3
• CMSIS 3.20
• Updated Visual Assist
• Command line utility for firmware upgrade
• Stimulus for simulator. Create a stimuli file to write register values while executing simulation.
1.9 **Atmel Studio 6.0**
- Support for Arm-based MCUs with SAM-ICE™
- Advanced Software Framework 3.1.3
- AVR Toolchain 3.4.0
- Arm Toolchain 3.3.1
- Advanced Software Framework Explorer
- Support for QTouch Composer as extension
- Updated Visual Assist
- New extension gallery

1.10 **AVR Studio 5.1**
- New version of AVR Software Framework (ASF)
- Availability and installation of new ASF versions through extension manager, without having to upgrade Studio 5
- Support for side by side versioning of ASF, with the ability to upgrade projects
- Syntax highlighting and better debugging support for C++ projects
- Support for importing AVR 32 Studio C++ projects
- New version of AVR Toolchain
- New command line utility (atprogram) with support for all Microchip AVR tools and devices
- Enhancements to programming dialog including support for ELF programming
- New version of Visual Assist with several enhancements and bug-fixes
## Frequently Asked Questions

Frequently asked questions about Atmel Studio.

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What is the Atmel USB Driver?</strong></td>
<td>The Atmel USB Driver is a cumulative installer that bundles the required USB drivers for all tools.</td>
</tr>
<tr>
<td><strong>I get an error during installation of the Atmel USB Driver Package.</strong></td>
<td>During the installation of the Atmel USB Driver Package, you might get the error 0x800b010a - A certificate chain could not be built to a trusted root authority. This means that the certificate that signs the installer could not be validated using the certificate authority built into Windows®. The reason for not being able to validate the certificate is because the certificate chain needs to be updated through Windows Update. Make sure that you have received all updates so that Windows can validate the certificate. If you are not able to update your computer due to the computer being offline or restricted in some way, then the root certificate update can be downloaded from <a href="http://support2.microsoft.com/kb/931125">http://support2.microsoft.com/kb/931125</a>.</td>
</tr>
<tr>
<td><strong>Will Atmel Studio work in parallel with older versions of Atmel Studio, AVR Studio, and AVR32 Studio?</strong></td>
<td>Yes, it will work side-by-side between major and minor versions. Side-by-side installation with different build numbers is not possible. If you uninstall AVR Studio 4.0 or AVR32 Studio, be careful when manually deleting folders or registry entries after uninstalling. There might be other keys and folders deployed by Atmel Studio inside the Microchip folder and registry paths. Note that drivers may be incompatible between versions.</td>
</tr>
<tr>
<td><strong>Atmel Studio cannot find any debuggers or programmers when Norton AntiVirus is running.</strong></td>
<td>Atmel Studio might not show any connected tools if Norton AntiVirus is running. To make it work, make sure Norton AntiVirus allows atprogram.exe to communicate with Atmel Studio by adding atbackend.exe as an exception in the Norton AntiVirus allowed programs. This is the same with any anti-virus program that by default blocks ports.</td>
</tr>
<tr>
<td><strong>Windows shows a message box with the following message when attempting to run Atmel Studio installer: 'Windows cannot access the specified device, path or file. You may not have the appropriate permissions to access the item.'</strong></td>
<td>This might be caused by an anti-virus program blocking the installation of Atmel Studio. We have seen this with the Sophos antivirus package. Temporarily disable the Sophos service running on the machine (or any corresponding anti-virus service), and restart the installation.</td>
</tr>
<tr>
<td><strong>Atmel Studio takes a very long time to start but runs well in a VM environment.</strong></td>
<td>The Visual Studio Shell (and thus Atmel Studio) does a considerable amount of processing during start-up. Parts of the operations are WPF operations which benefit greatly from updated graphics libraries and drivers. Installing the latest graphics driver may give a performance boost both during normal operation and during start-up.</td>
</tr>
<tr>
<td><strong>Verification and programming often fail with a serial port buffer overrun error message when using STK500.</strong></td>
<td>This is a known issue. Due to DPC latency, serial communication can have buffer overruns on the UART chipset. A workaround which works for most systems is to use a USB to serial adapter.</td>
</tr>
<tr>
<td><strong>When launching from a guest account, the following error is displayed when starting Atmel Studio: 'Exception has been thrown by the target of an invocation'.'</strong></td>
<td>Atmel Studio neither installs nor runs under a guest account.</td>
</tr>
</tbody>
</table>
### Can install and run Atmel Studio from within a Virtual Machine?

Yes, with simulator there should be no issues. However, with physical devices like debuggers and programmers, the VM must offer support for physical USB and Serial port connections.

### How can I reduce the start-up time of Atmel Studio?

- Make sure you have uninstalled unwanted extensions
- Disable Allow Add-in components to load:
  1. Go to Tools, Options, Add-in/Macro Security.
  2. Then, uncheck the Allow Add-in components to load option.
- Disable the start-up page:
  1. Go to Tools, Options, Environment, Startup, At Startup.
  2. Select the Show empty environment option.

### How to improve studio performance for any supported version of Windows?

- Make sure your system has the latest version of the Windows Automation API
- Exclude the following directories and files from your antivirus scanner:
  - The Atmel Studio installation directory, and all files and folders inside it
  - %AppData%\Roaming\Atmel directory, and all files and folders inside it
  - %AppData%\Local\Atmel directory, and all files and folders inside it
  - Your project directories
- Visual Studio Shell requires a lot of swap space. Increase the paging file. Also, put the system to maximize performance. Both options are found in the System, Properties, Performance, Settings menu.

### Should I install the latest Windows Automation API 3.0?

Yes, if your OS is any of the following:

- Windows Server 2008

### How can I make sure my system has the latest Windows Automation API 3.0?

Your system has the latest Windows Automation API if you have Windows 7 or Windows 8. Only Windows XP, Windows Vista®, Windows Server® 2003, and Windows Server 2008 have the old version of the API. Find the UIAutomationCore.dll file in your system (normally found in the Windows folder) and compare the version number of that file. The version should be 7.X.X.X. for the new API. The latest API can be found at [http://support.microsoft.com/kb/971513](http://support.microsoft.com/kb/971513).

### My Project is large and it takes a long time to open. Is there any option to avoid this delay?

Visual Assist X parses all the files when we open the existing project. You could disable this option:

2. Uncheck the Parse all files when opening the project.

### I have a limited RAM size in my system and I work long hours in the same instance of Atmel Studio. After some time, Atmel Studio becomes slow on my system.

Press Ctrl+Shift+Alt+F12 twice to force Atmel Studio to garbage collect.

### How can I make my projects build faster?

You can enable the parallel build Option from Tools, Options, Builder, GNU Make, Make Parallel Execution Of Build. This option will enable the parallel execution feature in the GNU make utility. This option may cause the build log to be displayed unordered.

## 2.1 Compatibility with Legacy AVR Software and Third-party Products

### 2.1.1 How do I Import External ELF Files for Debugging?

Use the File → Open object file for debugging.

© 2019 Microchip Technology Inc.  Release Note  50002917A-page 12
2.1.2 How do I Reuse My AVR Studio 4 Projects with the New Atmel Studio?
1. Click the menu File → Import AVR Studio 4 project.
2. An "Import AVR Studio 4 Project" dialog will appear.
3. Type in the name of your project or browse to the project location by clicking the Browse button of the APFS File location Tab.
4. Name the new solution resulting from the conversion of your project in the Solution Folder Tab.
5. Click Next.
6. Atmel Studio will proceed with the conversion. Depending on the complexity and specificity of your project, there might be some warnings and errors. They will be shown in the Summary window.
7. Click Finish to access your newly converted project.

2.2 Atmel Studio Interface

2.2.1 How can I Start Debugging My Code? What is the Keyboard Shortcut for Debugging?
Unlike the AVR Studio 4 to build your project, without starting debugging, you should press F7.
If you need to rebuild your project after a change to the source files, press Ctrl+Alt+F7.
To Start debugging - press F5.
To open the Debugging Interface without running directly, press the Debug→Start Debugging and Break menu button, or press F11.
To start a line-by-line debugging press F10, to start an instruction by instruction debugging session - press F11.
To run your project without debugging, press the Debug→Start Without Debugging menu button.

2.2.2 What is a Solution?
A solution is a structure for organizing projects in Atmel Studio. The solution maintains the state information for projects in .sln (text-based, shared) and .suo (binary, user-specific solution options) files.

2.2.3 What is a Project
A project is a logic folder that contains references to all the source files contained in your project, all the included libraries and all the built executables. Projects allow seamless reuse of code and easy automation of the build process for complex applications.

2.2.4 How can I use an External Makefile for my Project?
The usage of external makefiles and other project options can be configured in the project properties.
Remember that an external makefile has to contain the rules needed by Atmel Studio to work.

2.2.5 When Watching a Variable, the Debugger says Optimized away
Most compilers today are what is known as an optimizing compiler. This means that the compiler will employ some tricks to reduce the size of your program or speed it up.
Note: This behavior is usually controlled by the -On switches.
The cause of this error is usually trying to debug parts of the code that does nothing. Trying to watch the variable a in the following example may cause this behavior.

```c
int main() {
    int a = 0;
    while (a < 42) {
        a += 2;
    }
}
```

The reason for a to be optimized away is obvious as the incrementation of a does not affect any other part of our code. This example of a busy-wait loop is a prime example of unexpected behavior if you are unaware of this fact.
To fix this, either lower the optimization level used during compilation or preferably declare a as volatile. Other situations where a variable should be declared volatile is if some variable is shared between the code and an ISR\(^3\).

For a thorough walkthrough of this issue, have a look at Cliff Lawson’s excellent tutorial on this issue.

### 2.2.6 When Starting a Debug Session, I get an Error Stating that Debug Tool is not Set

The reason for this message is that there is no tool selected capable to debug your project. When no tool has been selected, it is empty. Clicking on the drop-down menu will show all the available tools. Go to the Tool project pane and change to a supported tool (Project Properties > Tool > Select debugger/programmer).

If the tool you have selected does support debug, then check that the correct interface is chosen and that the frequency is according to the specification. If the issue persists, try to lower the frequency to a frequency where programming is stable, and then slowly increase the frequency as long as it keeps stable.

### 2.3 Performance Issues

#### 2.3.1 Atmel Studio Takes a Very Long Time to Start on My PC but Runs Well in a VM Environment. Is there Something I Can Do With This?

Visual Studio shell (and thus Atmel Studio) uses WPF as a graphics library and does a lot of processing in the GUI thread. WPF has support for hardware acceleration. Some graphics card drivers do not utilize this well and spend time in kernel space even when no graphics update is required. Installing the latest graphics driver may give a performance boost.

#### 2.3.2 Verification and Programming often Fails with a Serial Port Buffer Overrun Error Message when using STK500

This is a known issue. Interrupt DPC latency for serial communication may be disrupted by other drivers, thus causing buffer overruns on the UART chipset. A workaround which works for most systems is to use a USB to serial adapter.

#### 2.3.3 I've connected my Tool through a USB Hub, and now I get Error Messages and Inconsistent Results while Programming and Debugging

Tools and devices should be connected directly to a USB port on your debugging PC. If this is not an option, you may reduce/eliminate problems by:

- Disconnect any other USB devices connected to the hub
- Switch ports on the USB hub
- Set the tool clock frequency low. E.g., Set JTAG Clock < 600 kHz.
- If Use external reset is an option for your tool/device combination, enable this

**Note:** The AVR Dragon should be connected through a powered USB hub. This because the power supply on the Dragon can be too weak if the motherboard does not provide enough power. If the Dragon times out or freezes, then the hub might be of too low quality.

### 2.4 Driver and USB Issues

#### 2.4.1 How do I get my Tool to be recognized by Atmel Studio?

This should happen automatically, but sometimes the Windows\(^\circ\) driver does not recognize the tool correctly. To correct this, you have to check that the tool is listed under the Microchip node in the device manager in Windows. If your tool is not listed, try to find it under Unknown devices. If it is located there, try to reinstall the driver by double-clicking the tool, click the Driver tab, and choose Update Driver. Let Windows search for the driver. The driver should be reinstalled, and the tool should be displayed under Microchip. Now, the tool should be usable from Atmel Studio.

---

\(^3\) Interrupt Service Routine
2.4.2 The Firmware upgrade Process fails or is Unstable on a Virtualized Machine
Most tools will perform a reset when asked to switch from normal operation mode to firmware upgrade mode. This forces the tool to re-enumerate on the USB bus. The Virtualization software may fail to reattach after the re-enumeration, resulting in a disconnected tool.

Normal virtualization software supports the idea of USB filters where you set a collection of USB devices you want to automatically attach to a given guest operating system. Check the manual for your virtualization solution to see how this is done, or see the 2.4.4 Firmware Upgrade Fails on VirtualBox.

2.4.3 Debugging never Breaks under a Virtualized Machine
Some virtualization solutions have a limit on how many USB endpoints it supports. This may become an issue if the number of endpoints is lower than the required number for the tool. Usually, this causes programming to work as expected but debug not to work as debug events are transmitted on a higher endpoint number.

Check with your virtualization software how many endpoints are available and on other endpoint-specific issues with your virtualization software regarding this.

2.4.4 Firmware Upgrade Fails on VirtualBox
When doing a firmware upgrade on any tool, the tool needs to be reconnected in another mode than the one used during regular operation. This causes the tool to be re-enumerated and can cause the tool to be disconnected from the VirtualBox instance and returned to the host operating system.

To make the tool connect automatically to the VirtualBox instance, you need to set up a couple of USB filters. More information on USB filters can be found in the VirtualBox documentation.

Make two filters that are similar to the two shown in the figure below.
Note that the example in the figure above is specific for the JTAGICE mkII. There is one entry for the tool, here the JTAGICE mkII, and one for AVRBLDR, which is the firmware upgrade mode for the tool. The name, serial, Vendor ID, and Product ID may be different for your tool, so change those values accordingly.

Note: This section contains specifics to VirtualBox. The same logic applies to other virtualization software, but the steps may differ.

2.4.5 Issues with Arm Compatible Tools

In some rare instances, all Arm compatible tools disappear from Atmel Studio. This has been tracked down to different dll load strategies used in different versions of Windows.

To check that it is a dll load error, try to read out the chip information using atprogram. This can be done by opening the Atmel Studio command prompt from the Tools menu inside Atmel Studio or the start menu. In the command prompt, enter the following command and check that it does not fail.

```
 atprogram -t <tool> -i <interface> -d <device> info
```

In the snippet above, replace <tool> with the tool name, e.g., atmelice, samice or edbg. Likewise, replace interface with the used interface and the device with the full device name, e.g., atsam3s4c.

Invoking the above command should output information about the memory layout, the supply voltage for the chip, and the fuse settings. If it fails, it is likely a driver issue, which is covered by 2.4 Driver and USB Issues.

If the atprogram can communicate with the device, it means that the issue is most likely a wrong version of JLinkArm.dll being loaded due to loader precedence. To check this, use the Procmon tool to check what dll is being loaded.
Download the Procmon tool, open it, and configure the filter as shown in the figure below and start Atmel Studio. A couple of seconds after Atmel Studio has started, one line should become visible showing the path to where the dll is being loaded from. It should be loaded from the atbackend folder inside the Atmel Studio installation directory.

**Figure 2-2. Procmon Filter Configuration**

If the path of the dll is different, it means that Atmel Studio has picked up the wrong dll, and this dll is incompatible with the dll shipped with Atmel Studio. An example of this is shown in the figure below.

**Figure 2-3. Procmon Filter Configuration**

To solve the above issue, we recommend backing up the dll that is being loaded and then replacing it with the JLinkArm.dll found in the atbackend directory inside the Atmel Studio installation directory. This can be done given the assumption that the dll bundled with Atmel Studio is newer than the one being loaded, and the dll is backward compatible.

**Note:** Remember to back up the offending JLinkArm.dll before replacing it, as it is not given that it will be compatible with the program that deployed it.
3. **Installation**

Installation instructions.

**Supported Operating Systems**

- Windows 7 Service Pack 1 or Higher
- Windows Server 2008 R2 Service Pack 1 or Higher
- Windows 8/8.1
- Windows Server 2012 and Windows Server 2012 R2
- Windows 10

**Supported Architectures**

- 32-bit (x86)
- 64-bit (x64)

**Hardware Requirements**

- A Computer With a 1.6 GHz or Faster Processor
- RAM:
  - 1 GB RAM for x86
  - 2 GB RAM for x64
  - An additional 512 MB RAM if running in a Virtual Machine
- 6 GB of Available Hard Disk Space

**Downloading and Installing**

- Download the latest Atmel Studio installer
- Atmel Studio can be run side-by-side with older versions of Atmel Studio and AVR Studio. Uninstallation of previous versions is not required.
- Verify the hardware and software requirements from the 'System Requirements' section
- Make sure your user has local administrator privileges
- Save all your work before starting. The installation might prompt you to restart if required.
- Disconnect all USB/Serial hardware devices
- Double-click the installer executable file and follow the installation wizard
- Once finished, the installer displays an option to **Start Atmel Studio after completion**. If you choose to open, then note that Atmel Studio will launch with administrative privileges, since the installer was either launched as an administrator or with elevated privileges.
4. Extensions

This section contains information about the Extension Manager and the extension ecosystem.

Extensions and updates to Atmel Studio are available through the Microchip Gallery. Access it through https://gallery.microchip.com/policies/studio or use the extension manager in Atmel Studio under the Tools menu.

The set of extensions supporting a given Atmel Studio version may vary. Visit https://gallery.microchip.com/policies/studio to see which extensions are available for a given version of Atmel Studio. Note that at the time of the release of a new version of Atmel Studio, not all extensions have been ported from the previous version.

Atmel Studio does not automatically reinstall extensions installed on previous versions of Atmel Studio.
5. Features and Bugs

New Features

Notable Bugs Fixed

Known Issues

- **AVRSV-283**: webproperties.tlb file missing.
  A message saying "webproperties.tlb could not be located" can be displayed on some systems. A workaround for this problem is to make a copy of a file named "webproperties???.tlb" in "C:\Program Files (x86)\Common Files\microsoft shared\MSEnv" (on the same location) and rename it to "webproperties.tlb".

- **AVRSV-414**: Handle Power toggle and external reset for all emulators and architectures/families.
  Power toggle and external reset is not handled gracefully in all situations.

- **AVRSV-546**: .NET Framework install might not work if there is limited network connectivity.
  The .NET Framework installer might not work properly if network connectivity is limited. If connectivity is limited disconnect from the network or disable all active network adapters before starting installation of Atmel Studio.

- **AVRSV-628**: Scrolling memory view does not work properly.
  Scrolling memory view does not work properly. It is not possible to use the slider in the memory view to scroll it. Only the up and down arrows works.

- **AVRSV-680**: Breakpoint is not updating in the Disassembly and Code view.
  Sometimes breakpoints that are set in the Source Editor are not reflected correctly in the Disassembly Window while debugging.

- **AVRSV-831**: .NET install fail because Windows Imaging Component WIC is not installed.
  Atmel Studio installation may fail on XP systems if the Microsoft Windows Imaging Component (32-bit) is not installed. Install this component, downloadable from Microsoft.

- **AVRSV-966**: Installer crashes when trying to install from "runas" option.
  Running the Atmel Studio installer using the "run as" option on Windows XP may crash the installer.

- **AVRSV-1192**: Internet Explorer 6 does not show user documentation correctly.
  Internet Explorer 6 will not render the navigation menu in the user documentation correctly.

- **AVRSV-1254**: The asf.h header file is not included in all examples.
  The asf.h header file is not included in all examples. Workaround: Include this file manually if you add additional drivers using the "Select Drivers from AVR Software Framework" dialog.

- **AVRSV-1533**: Microsoft Visual Studio 2010 Shell --> Error: Cannot publish because a project failed to build.
  Visual Studio 2010 RC/Beta version has conflict with RTM version of Microsoft Visual Studio 2010 Isolated Shell. The workaround is to uninstall Microsoft Visual Studio 2010 isolated Shell that is installed with Atmel Studio.

- **AVRSV-1557**: Mapped network drives do not appear in Project Location window.
  Mapped network drives do not appear in the Project Location window when creating a new project.

- **AVRSV-1603**: shared register access not possible?.
  When debugging on ATmega16[A] or ATmega32[A] devices it is not possible to read out the value of UBRRH using the debugger.

- **AVRSV-1675**: Tool marked as available even though OS driver is not installed.
  If a driver for a tool has not been installed (first time it's plugged in) and the user plugs the tool into the PC when Atmel Studio is running then it will be shown in the "Available Tools" view but not have access to the tool as a OS driver for the
<table>
<thead>
<tr>
<th>Issue Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVRSV-1733</td>
<td>Single step over SW reset on Xmega does not work. Stepping in the source view over a software reset may leave the target running on ATxmega devices.</td>
</tr>
<tr>
<td>AVRSV-1758</td>
<td>Non-Latin characters in project paths are not supported. Projects which include paths or files with non-Latin characters are not supported.</td>
</tr>
<tr>
<td>AVRSV-1760</td>
<td>Issues with AVR Studio 5 installed alongside Visual Studio 2010 SP1. Service Pack 1 of Visual Studio 2010 installed on a PC where Atmel Studio 6 is installed, may initiate a need for reapplying the SP1 installer. A dialog box will then appear during startup of Atmel Studio, and detail the steps that must be taken.</td>
</tr>
<tr>
<td>AVRSV-1883</td>
<td>PORT registers in IO view behaves incorrectly. The IO window does not fully support registers like e.g. DIRSET, DIRTGL, and DIRCLR for the XMEGA family (used to manipulate a corresponding DIR register). Toggling the value of bits in these registers have undefined result on DIR.</td>
</tr>
<tr>
<td>AVRSV-1888</td>
<td>Detect m103c compatibility fuse setting on atmega128. Debugging Atmega128 in ATmega103 compatibility mode is not supported.</td>
</tr>
<tr>
<td>AVRSV-1895</td>
<td>VAssistX: Alt + G does not open file &lt;avr/io.h&gt;. 'Alt + G' does not open the file &lt;avr/io.h&gt;. This file is not parsed by Visual Assist.</td>
</tr>
<tr>
<td>AVRSV-1901</td>
<td>Solution with two projects does not work. Creating two projects in the same solution which have different devices is not supported. Create two different solutions instead.</td>
</tr>
<tr>
<td>AVRSV-2022</td>
<td>Conflicts with Folding@Home. Running Folding@home together with Atmel Studio may cause unresponsive user interface. We recommend to disable the Folding@home when running Atmel Studio.</td>
</tr>
<tr>
<td>AVRSV-2163</td>
<td>File/Folder names with spaces are not built property. Files or folders with more than one consequent spaces are not supported as part of AVRStudio 5 projects.</td>
</tr>
<tr>
<td>AVRSV-2558</td>
<td>HVPP for ATtiny2313A does not work on STK500. HVPP for ATtiny2313A does not work on STK500.</td>
</tr>
<tr>
<td>AVRSV-2601</td>
<td>VS6 incompatibility with AS5. During installation of Atmel Studio, the Visual Studio 2010 Shell installation will re-register the ‘vsjitdebugger’. This might make Visual Studio 2008 and Visual Studio 2005 unable to debug a crashed application reported by Windows. Workaround: Run repair of Visual Studio on top of the Atmel Studio installation. This should re-enable the capability of Visual Studio to get a chance to handle crashed applications.</td>
</tr>
<tr>
<td>AVRSV-2884</td>
<td>AVR Studio cannot create a project from template with a deep file architecture. Project creation may fail when file/folder name of the project or its sub-items name exceeds 256 characters limit.</td>
</tr>
<tr>
<td>AVRSV-3296</td>
<td>Visual assist inserts the c++ keywords, functions in C project. Autocompletion and snippets provided by Visual Assist can generate invalid embedded C++, and it might also try to insert C++ in a C project. This includes exceptions, classes and namespace declarations.</td>
</tr>
<tr>
<td>AVRSV-3313</td>
<td>In Atmel Studio 6.1 compilation fails for ASF Projects created with AVR Studio 5.1. If you encounter the error : variable 'xxxx' must be const in order to be put into read-only section by means of ‘<em>attribute</em>((progmem))’, then this description applies. The problem is due to the incompatibility of the ASF source code with the AVR GCC compiler. The GCC 4.6 Release document (<a href="http://gcc.gnu.org/gcc-4.6/changes.html">http://gcc.gnu.org/gcc-4.6/changes.html</a>) mentions that the error is expected and to use the ASF</td>
</tr>
</tbody>
</table>
projects created in 5.1 (i.e ASF 2.9.0) we have to use avr gcc toolchain version 3.3.1 and for later ASF versions use 3.4.0. Alternatively you could manually add the const qualifier to the variable(s) that are reported, when compiling ASF 2.9.0 projects with AVR GCC toolchain 3.4.0 or later.

AVRSV-3672: Can't use network path in "New Example Project from ASF" dialog.
ASF projects cannot be created in UNC paths. To create the ASF project, map the UNC path to a network drive.

AVRSV-3993: JTAGICE3 event endpoint is not registered on virtual machines.
On virtual machines like VirtualBox, the event endpoint may not work properly and no events will be propagated from the tool to Atmel Studio. This mainly impacts debugging.

AVRSV-4005: Setting lockbits for SAM4LC4C have no effect.
Setting flash region lockbits when using SEGGER may have no effect, as the SEGGER tool may unlock the flash region before it writes to it at a later stage.

AVRSV-4050: User signature on RFR parts can only be accessed by JTAG or parallel programming.
User signature on RFR parts can only be accessed by JTAG or parallel programming.

AVRSV-4079: Unable to launch using an ELF file containing LOCKBITS.
Launching debug with an ELF file containing non-0xFF lockbits may fail. Lockbits should not be set for debugging.

AVRSV-4337: After Installing AtmelStudio 6.1, the old projects does not build in earlier versions of AtmelStudio.
Build abruptly fails in Atmel studio without proper error message and the error window shows no error. Tail of the Build Output: Task "RunCompilerTask"
Reason: Project file was upgraded from 6.0 to 6.1. Steps to Restore back the project to working condition: Scenario 1: (With Backup) Check whether there is a back up project in the projectfolder with the name ProjectName_6_0 (For Example the backup project is GccApplication1_6_0.cproj if the actual project name is GccApplication1.cproj) * Project with the name GccApplication1.cproj is the upgraded project to confirm edit the project file in editor you should be able to see <ProjectVersion>=6.1</ProjectVersion>. * Open the project GccApplication1_6_0.cproj in Atmel Studio 6.0. It should prompt you to save the solution file. Save and build it should work fine. Scenario 2: (Without Backup) If the backup project is not found in the project folder chances are that you would have upgraded the project from 6.0 to 6.1 without opting for the backup. * Edit the project file modify <ProjectVersion> tag and set the version to 6.0 and also modify the <ToolchainName> tag by removing .C or .CPP from the tag ( For example com.Atmel.AVRGCC32.C must be renamed as com.Atmel.AVRGCC32) build the project now.

AVRSV-4380: No error or warning is displayed when number of characters in command line arguments exceeds microsoft limitation.
When building a project in Atmel Studio, and if you get an error like the one as follows <some file>.o: No such file or directory during the linking stage, then it could be because of the number of characters in the command line. Windows expects that the command line be less than 8192 characters. To workaround the issue, reduce the name of the folder so that the command line becomes shorter.

AVRSV-4440: Breaking changes in SAM header files going from 6.0 to 6.1.
The SAM header files have been updated and due to this there are breaking changes when upgrading from 6.0 to 6.1. Bare bone SAM projects created with Atmel Studio 6.0 can get compilation errors due to changes in defines. You can continue to use the old headers by keeping Atmel Studio 6.0 and 6.1 installed in parallel and use the toolchain from 6.0. ASF projects are not affected.

AVRSV-4501: Path of toolchain's native libraries are wrong.
Toolchain libraries "Full Path" property will display the base path of the current toolchain.

AVRSV-4521: Expanding / collapsing node does not...
<table>
<thead>
<tr>
<th>Issue Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVRSV-4576</td>
<td>Modifying EEPROM data values in the memory view during debugging of XMEGA E5 devices causes the EEPROM data to be corrupted.</td>
</tr>
<tr>
<td>AVRSV-4659</td>
<td>Programming SAM4L and some UC3 kilogram programming fails with core voltage at &gt;1.9V.</td>
</tr>
<tr>
<td>AVRSV-4693</td>
<td>For COFF object file debugging, elements in the &quot;type&quot; field of a watch on a composite data type might contain the object/variable name instead of the type name.</td>
</tr>
<tr>
<td>AVRSV-4753</td>
<td>In the information window for Xplained Pro kits, the revision is not the actual chip revision, but the revision coded into the Xplained Pro itself. Use the Programming Dialog to read the correct revision from the device.</td>
</tr>
<tr>
<td>AVRSV-4899</td>
<td>Debugging inside the NMI handler on UC3 does not work. This is probably due to the fact that the NMI interrupt has a higher interrupt priority than breakpoints.</td>
</tr>
<tr>
<td>AVRSV-5029</td>
<td>Writing bitfields that needs to be written in a timed sequence from the I/O view will not work. This is the case for CLKPR, IVSEL and WDTEN, to mention some bitfields.</td>
</tr>
<tr>
<td>AVRSV-5050</td>
<td>If the BOOTPROT fuse is set in the device, flash memory may not get programmed correctly and no error will be displayed. If debugging, the program will not get uploaded, but debug will proceed with the wrong image.</td>
</tr>
<tr>
<td>AVRSV-5324</td>
<td>Modifying SAMD20 port registers like OUTSET, OUTCLR and OUTTGL will not have the expected result unless the full register value is taken into consideration. The mentioned registers reflects the current value of OUT when read by the user application and Atmel Studio. Clicking a single bit in one of these registers in the IO View will write back the full register with only the clicked bit toggled from its existing value, causing a set, clear or toggle action also on other set bits in that register. These considerations can be avoided by directly setting and clearing bits in the OUT (or corresponding) register.</td>
</tr>
<tr>
<td>AVRSV-5339</td>
<td>Variables in Live Watch are not updated when single stepping on UC3 devices.</td>
</tr>
<tr>
<td>AVRSV-5378</td>
<td>SAM devices: Interrupt flags that are cleared by reading a register, can unexpectedly be cleared by the debugger if the register is monitored in the I/O view or the Memory view in Atmel Studio. An example is the RXRDY flag for USART0 in SAM4LC4C, which might be cleared if the debugger breaks and reads the RHR register in order to display its value.</td>
</tr>
<tr>
<td>AVRSV-5450</td>
<td>During trace activation, Atmel Studio can silently fail to enable trace on multicore devices where the TRACESWO pin is shared by the cores through a mux that does not switch automatically to the active core. To be able to get trace on these devices, the mux for the TRACESWO signal needs to be set correctly by the users application.</td>
</tr>
</tbody>
</table>
| AVRSV-5527  | The Live Watch feature in Atmel Studio does not work well with expressions as the variable. Since the watch in this case is on a memory address, the Live Watch implicitly adds a ampersand (&) before the variable being watched to
<table>
<thead>
<tr>
<th>AVRSV-5635: Unable to debug when assigning fuse bits through .elf.</th>
<th>extract the address of the variable. This means that expressions will be evaluated to the wrong value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVRSV-5711: Cannot debug SAM D code with Atmel Studio if .text section is relocated.</td>
<td>Care should be taken when debugging a project with embedded fuse information. The debugging session might misbehave if the fuses overwrites settings that Atmel Studio assumes to have control over.</td>
</tr>
<tr>
<td>AVRSV-5792: Installing 6.2 public after 6.2 ServicePack1 corrupts the Service pack installation.</td>
<td>relocating the .text segment may cause the debugger to fail in certain conditions. This results in 'Start debugging and break' to stop at a high address in the disassembly view. To make the debugger break the application entry, tick the 'Override VTOR' option in the project properties, and ensure that the text box contains the address of the interrupt vector. This is usually 'exception_table' or '&amp;exception_table', depending on the startup code in the project. The difference between these is that '&amp;exception_table' is a struct, while 'exception_table' is a function pointer array.</td>
</tr>
<tr>
<td>AVRSV-5792: Installing 6.2 public after 6.2 ServicePack1 corrupts the Service pack installation.</td>
<td>Installation of Atmel Studio 6.2.1153 after Atmel Studio 6.2 Service Pack 1 cannot co-exist so always uninstall Atmel Studio 6.2 Service Pack 1 before installing Atmel Studio 6.2.1153.</td>
</tr>
<tr>
<td>AVRSV-5837: Backend times out if &quot;USE GDB&quot; is selected for UC3 devices.</td>
<td>Trying to enable GDB for AVR32 projects will probably fail in even the simplest debugging, such as Halt, Step, and Go. It is not recommended to ignore the warning shown when this option is enabled for a project.</td>
</tr>
<tr>
<td>AVRSV-5854: Installation of USB Driver package fails on clean Win 7 (64-bit) machine.</td>
<td>The Atmel USB Driver Package may fail during installation with error '0x800b010a - A certificate chain could not be built to a trusted root authority'. The reason for this is that the built in certificate in Windows is out of date and needs to be updated through Windows Update. If you are unable to perform a update, then the update can be manually downloaded from KB931125 from Microsoft.</td>
</tr>
<tr>
<td>AVRSV-5952: Firmware upgrade fails from jtagice3v2.15 to jtagice3+.</td>
<td>Upgrading JTAGICE3 from major version 1 or 2 to major version 3 can fail. The first firmware upgrade attempt will only put the JTAGICE3 into boot mode, and not do an actual upgrade. Running a second firmware upgrade without toggling power to the tool should work. The simplest workaround is to use atfw found in '&lt;Atmel Studio installation folder\atbackend'. From a command prompt (inside Atmel Studio, go to Tools\Command Prompt) run&quot;atfw.exe -t jtagice3 -a &quot;&lt;Atmel Studio installation folder\tools\jtagice3\jtagice3_fw.zip&quot;, which would normally be atfw -t jtagice3 -a &quot;C:\Program Files (x86)\Atmel\Atmel Studio 6.2\tools\jtagice3\jtagice3_fw.zip&quot;. The first attempt will fail, but when running the command again without toggling power on the JTAGICE3 it should pass. Note that as soon as the JTAGICE3 has been upgraded to a firmware with major version 3 or higher, firmware upgrade should work on first attempt also from Atmel Studio 6.2 SP1.</td>
</tr>
<tr>
<td>AVRSV-5987: Cannot chip erase SAM4L in backup mode on SAMICE.</td>
<td>Atmel Studio would not be able to erase a SAM4L part if the part was put into a sleep mode immediately after startup. Note that a POR may be required after programming to be able to establish contact.</td>
</tr>
<tr>
<td>AVRSV-6364: ARP entry added into the control panel even if one of the packages get installed by the bootstrapper.</td>
<td>Atmel Studio 7.0 entry will be visible in Add Remove programs even if the installation is unsuccessful or partial. Please remove the entry and try installing again.</td>
</tr>
</tbody>
</table>
| AVRSV-6372: Installing Atmel Studio Extensions does not seem to detect Atmel Studio 7.0. | If VSIX (Atmel Studio extensions) are installed manually, there might be conflicts between Atmel Studio and Visual Studio due to issues in the Microsoft Visual Studio Version Selector (VSLauncher.exe) executable. To fix this, change the file association for VSIX files from VSLauncher.exe to C:\Program Files (x86)\Microsoft Visual Studio 12.0\Common7\IDE\VSIXInstaller.exe (D:\Program Files\Microsoft Visual Studio 12.0\Common7\IDE\VSIXInstaller.exe on 32-bit systems). Changing the file association is done by Shift-Right Click the VSIX,
choose 'Open With...' and browse to the VSIXInstaller.exe in the path shown above.

**AVRSV-6405: Device disconnected error comes after updating firmware. But allows to debug program.**

Tools may fail to re-enumerate after a firmware upgrade, causing the tool to be listed as disconnected. If this happens, reconnect the tool and it should re-enumerate and become connected again.

**AVRSV-6427: Abort of Uninstall sequence leaves the system in intermediate state.**

If the system goes into an intermediate state after abort of uninstall sequence (forceful exit of installation process) the state could be recovered by repairing Atmel Studio 7.0 from control panel.

**AVRSV-6664: Atmel Studio crashes when I search in the options dialog.**


**AVRSV-6677: Issues with graphics driver can cause rendering glitches.**

Atmel Studio tries to offload as much of the graphics rendering of the user interfaces as possible to the graphics card to free up CPU resources. If the graphics driver does not support hardware rendering, Atmel Studio will fall back to using software rendering. However, in some cases, this fallback does not work for some reasons, causing rendering glitches in the user interface. The best way to solve this issue is to make sure that the latest graphics driver is installed from your graphics card vendor.

**AVRSV-6848: Upgrading JTAGICE3v1 and v2 to v3 works, but studio needs to be restarted.**

Atmel Studio fails to connect to JTAGICE3 after upgrading from firmware version 1 or version 2. To be able to connect, Atmel Studio needs to be restarted.

**AVRSV-7003: Current measurements does not work when running debugging or programming at low baud.**

Running current measurements in Data Visualizer while programming or debugging at low interface frequencies/baud rates might result in Data Visualizer disconnecting from the Power Debugger. The lower limit of the interface speed varies depending on target type, flash size and interface type but is typically in the range 100-300kHz.

**AVRSV-7154: Studio upgrade breaks functionality for other users on the same computer.**

If a USER is using an Atmel Studio installed by another user ADMIN (USER! =ADMIN), and Atmel Studio is updated by ADMIN, Atmel Studio will still be using the old extensions that were copied to the %appdata% folders. To correct, the USER must delete the %appdata%\Atmel (roaming and local) folders so that they are reinitialized by the new version of Atmel Studio on the next start.

**AVRSV-7163: Installing AVR8 Toolchain 7.0: 'An error occured: The specified account already exists'.**

Run 'Microsoft Fix' it and uninstall 'AVR8 Toolchain 7.0'. After this, run the Atmel Studio installer and choose repair.

**AVRSV-7235: Atmel Studio crashes when searching in the Solution Explorer.**

On some machines, Atmel Studio can crash when searching for files in the Solution Explorer. Currently, only workaround is to install Visual Studio 2015 Update 2 or newer on the machine.

**AVRSV-7309: Multiple Windows security dialog boxes during driver install on Windows 7.**

Some Windows 7 machines can experience multiple security dialog boxes during the driver installation. Clicking the Trust this publisher checkbox does not work. This is related to KB2921916, this hotfix can be downloaded from https://support.microsoft.com/en-us/kb/2921916.

**AVRSV-7828: Error during driver installation on Windows 7 32-bit.**

The drivers may fail during upgrade on Windows 7 32-bit. A workaround is to uninstall Atmel Studio and the Atmel Driver from Add/Remove programs before installing again.
AVRSV-7931: Arduino sketch project with custom libraries fails to compile in studio.

To fix this compilation error, after project creation, navigate to ArduinoCore/Src/Libraries/Adafruit-GFX-Library-master/fontconvert/fontconvert.c. Exclude fconvert.c from compilation by setting Build Action for this file to None.

Other Issues Fixed
6. Device Support

Device support in Atmel Studio is done using the concept of device family packs. The format is inspired by the Keil® CMSIS-Pack specification, and packs containing Arm devices are fully compatible with the Keil CMSIS-Pack specification. For AVR and AVR32 packs, some Microchip specific extensions to the format have been implemented.

CMSIS-Pack describes a couple of use cases, and the packs used in Atmel Studio to provide device support is part of the Device Family Pack (DFP) use case. This pack contains all needed files to support compilation, programming and debugging of a device. More information about the CMSIS-Pack specification, visit http://www.keil.com/pack/doc/CMSIS/Pack/html/index.html.

Atmel Studio includes a tool to manage packs, called Pack Manager. It is available in the Tools menu in Atmel Studio and gives the ability to install, remove and list information related to packs.

6.1 Device Notes

Information about mature devices.

The following mature devices are not recommended for new designs:

- ATtiny11
- ATtiny12
- ATtiny15
- ATtiny22
- AT90S1200
- AT90S2313
- AT90S2323
- AT90S2343
- AT90S4433
- AT90S8515
- AT90S8535
- ATmega323
- ATmega161
- ATmega163
- ATmega103
- ATmega165
- ATmega169
- ATmega64HVE
- ATmega32U6
- AT90PWM2
- AT90PWM3
- AT90SCR100
- AT86RF401

See https://www.microchip.com/ for replacements.
# Revision History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Changed to Microchip standard and a new Microchip document number is set up.</td>
</tr>
<tr>
<td>K</td>
<td>Adding June 2018 release of Atmel Studio</td>
</tr>
<tr>
<td>J</td>
<td>Adding October 2017 release of Atmel Studio</td>
</tr>
<tr>
<td>I</td>
<td>Adding March 2017 USB driver update of Atmel Studio</td>
</tr>
<tr>
<td>H</td>
<td>Adding March 2017 release of Atmel Studio</td>
</tr>
<tr>
<td>G</td>
<td>Adding September 2016 release of Atmel Studio</td>
</tr>
<tr>
<td>F</td>
<td>Adding June 2016 release of Atmel Studio</td>
</tr>
<tr>
<td>E</td>
<td>Adding May 2016 release of Atmel Studio, released as revision D</td>
</tr>
<tr>
<td>D</td>
<td>Adding February 2016 release of Atmel Studio</td>
</tr>
<tr>
<td>C</td>
<td>Never released</td>
</tr>
<tr>
<td>B</td>
<td>Initial document for version 7.0 of Atmel Studio</td>
</tr>
<tr>
<td>A</td>
<td>Never released</td>
</tr>
</tbody>
</table>
The Microchip Website

Microchip provides online support via our website at http://www.microchip.com/. This website is used to make files and information easily available to customers. Some of the content available includes:

- **Product Support** – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
- **General Technical Support** – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip design partner program member listing
- **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service

Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will receive email notification whenever there are changes, updates, revisions or errata related to a specified product family or development tool of interest.

To register, go to http://www.microchip.com/pcn and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

- Distributor or Representative
- Local Sales Office
- Embedded Solutions Engineer (ESE)
- Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: http://www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Legal Notice

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with
your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless otherwise stated.

**Trademarks**

The Microchip name and logo, the Microchip logo, Adaptec, AnyRate, AVR, AVR logo, AVR Freaks, BesTime, BitCloud, chipKIT, chipKIT logo, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, HELDO, IGLOO, JukeBlox, KeeLoq, Kleer, LANCheck, LinkMD, maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST, MOST logo, MPLAB, OptoLyzer, PackTe, PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer, QTouc, SAM-BA, SenGenuity, SpyNIC, SST, SST Logo, SuperFlash, Symmetricom, SyncServer, Tachyon, TempTrackr, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

APT, ClockWorks, The Embedded Control Solutions Company, EtherSynch, FlashTec, Hyper Speed Control, HyperLight Load, IntelliMOS, Libero, motorBench, mTouch, Powermite 3, Precision Edge, ProASIC, ProASIC Plus, ProASIC Plus logo, Quiet-Wire, SmartFusion, SyncWorld, Temux, TimeCesium, TimeHub, TimePictra, TimeProvider, Vite, WinPath, and ZL are registered trademarks of Microchip Technology Incorporated in the U.S.A.


SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered trademarks of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.

© 2019, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.


**Quality Management System**

## Worldwide Sales and Service

### AMERICAS

<table>
<thead>
<tr>
<th>Location</th>
<th>Contact Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atlanta</td>
<td>Tel: 678-957-9614 Fax: 678-957-1455</td>
</tr>
<tr>
<td>Austin, TX</td>
<td>Tel: 512-257-3370</td>
</tr>
<tr>
<td>Boston</td>
<td>Tel: 774-760-0087 Fax: 774-760-0088</td>
</tr>
<tr>
<td>Chicago</td>
<td>Tel: 630-285-0071 Fax: 630-285-0075</td>
</tr>
<tr>
<td>Detroit</td>
<td>Tel: 248-848-4000</td>
</tr>
<tr>
<td>Houston, TX</td>
<td>Tel: 281-894-5983</td>
</tr>
<tr>
<td>Indianapolis</td>
<td>Tel: 317-773-8323 Fax: 317-773-5453 Tel: 317-536-2380</td>
</tr>
<tr>
<td>Los Angeles</td>
<td>Tel: 949-462-9523 Fax: 949-462-9608 Tel: 951-273-7800</td>
</tr>
<tr>
<td>Raleigh, NC</td>
<td>Tel: 919-844-7510</td>
</tr>
<tr>
<td>New York, NY</td>
<td>Tel: 631-435-6000</td>
</tr>
<tr>
<td>San Jose, CA</td>
<td>Tel: 408-735-9110 Tel: 408-436-4270</td>
</tr>
<tr>
<td>Canada - Toronto</td>
<td>Tel: 905-695-1980 Fax: 905-695-2078</td>
</tr>
</tbody>
</table>

### ASIA/PACIFIC

<table>
<thead>
<tr>
<th>Location</th>
<th>Contact Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia - Sydney</td>
<td>Tel: 61-2-9868-6733</td>
</tr>
<tr>
<td>China - Beijing</td>
<td>Tel: 86-10-8569-7000</td>
</tr>
<tr>
<td>China - Chengdu</td>
<td>Tel: 86-28-8665-5511</td>
</tr>
<tr>
<td>China - Chongqing</td>
<td>Tel: 86-23-8980-9588</td>
</tr>
<tr>
<td>China - Dongguan</td>
<td>Tel: 86-769-8702-9880</td>
</tr>
<tr>
<td>China - Guangzhou</td>
<td>Tel: 86-20-8755-8029</td>
</tr>
<tr>
<td>China - Hangzhou</td>
<td>Tel: 86-571-8792-8115</td>
</tr>
<tr>
<td>China - Hong Kong SAR</td>
<td>Tel: 852-2943-5100</td>
</tr>
<tr>
<td>China - Nanjing</td>
<td>Tel: 86-25-8473-2460</td>
</tr>
<tr>
<td>China - Qingdao</td>
<td>Tel: 86-532-8502-7355</td>
</tr>
<tr>
<td>China - Shanghai</td>
<td>Tel: 86-21-3326-8000</td>
</tr>
<tr>
<td>China - Shenyang</td>
<td>Tel: 86-24-2334-2829</td>
</tr>
<tr>
<td>China - Shenzhen</td>
<td>Tel: 86-755-8864-2200</td>
</tr>
<tr>
<td>China - Suzhou</td>
<td>Tel: 86-186-6233-1526</td>
</tr>
<tr>
<td>China - Wuhan</td>
<td>Tel: 86-27-5980-5300</td>
</tr>
<tr>
<td>China - Xian</td>
<td>Tel: 86-29-8833-7252</td>
</tr>
<tr>
<td>China - Zhuhai</td>
<td>Tel: 86-992-2388138</td>
</tr>
<tr>
<td>India - Bangalore</td>
<td>Tel: 91-80-3090-4444</td>
</tr>
<tr>
<td>India - New Delhi</td>
<td>Tel: 91-11-4160-8631</td>
</tr>
<tr>
<td>India - Pune</td>
<td>Tel: 91-20-4121-0141</td>
</tr>
<tr>
<td>Japan - Osaka</td>
<td>Tel: 81-5-6152-7160</td>
</tr>
<tr>
<td>Japan - Tokyo</td>
<td>Tel: 81-3-6880-3770</td>
</tr>
<tr>
<td>Korea - Daegu</td>
<td>Tel: 82-53-744-4301</td>
</tr>
<tr>
<td>Korea - Seoul</td>
<td>Tel: 82-2-554-7200</td>
</tr>
<tr>
<td>Malaysia - Kuala Lumpur</td>
<td>Tel: 60-3-7651-7906</td>
</tr>
<tr>
<td>Malaysia - Penang</td>
<td>Tel: 60-4-227-8870</td>
</tr>
<tr>
<td>Philippines - Manila</td>
<td>Tel: 63-2-634-9065</td>
</tr>
<tr>
<td>Singapore</td>
<td>Tel: 65-6334-8870</td>
</tr>
<tr>
<td>Taiwan - Hsin Chu</td>
<td>Tel: 886-3-577-8366</td>
</tr>
<tr>
<td>Taiwan - Kaohsiung</td>
<td>Tel: 886-7-213-7830</td>
</tr>
<tr>
<td>Taiwan - Taipei</td>
<td>Tel: 886-2-2508-8600</td>
</tr>
<tr>
<td>Thailand - Bangkok</td>
<td>Tel: 66-2-694-1351</td>
</tr>
<tr>
<td>Vietnam - Ho Chi Minh</td>
<td>Tel: 84-28-5448-2100</td>
</tr>
</tbody>
</table>

### EUROPE

<table>
<thead>
<tr>
<th>Location</th>
<th>Contact Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austria - Wels</td>
<td>Tel: 43-7242-2244-39 Fax: 43-7242-2244-393</td>
</tr>
<tr>
<td>Denmark - Copenhagen</td>
<td>Tel: 45-4450-2828 Fax: 45-4485-2829</td>
</tr>
<tr>
<td>Finland - Espoo</td>
<td>Tel: 358-9-4520-820</td>
</tr>
<tr>
<td>France - Paris</td>
<td>Tel: 33-1-69-53-63-20 Fax: 33-1-69-30-90-79</td>
</tr>
<tr>
<td>Germany - Garching</td>
<td>Tel: 49-8931-9700</td>
</tr>
<tr>
<td>Germany - Haan</td>
<td>Tel: 49-2129-3766400</td>
</tr>
<tr>
<td>Germany - Heilbronn</td>
<td>Tel: 49-7731-72400</td>
</tr>
<tr>
<td>Germany - Karlsruhe</td>
<td>Tel: 49-721-625370</td>
</tr>
<tr>
<td>Germany - Munich</td>
<td>Tel: 49-89-627-144-0 Fax: 49-89-627-144-44</td>
</tr>
<tr>
<td>Germany - Rosenheim</td>
<td>Tel: 49-8031-354-560</td>
</tr>
<tr>
<td>Israel - Ra'anana</td>
<td>Tel: 972-9-744-7705</td>
</tr>
<tr>
<td>Italy - Milan</td>
<td>Tel: 39-0331-742611 Fax: 39-0331-466781</td>
</tr>
<tr>
<td>Italy - Padova</td>
<td>Tel: 39-049-7625286</td>
</tr>
<tr>
<td>Netherlands - Drunen</td>
<td>Tel: 31-416-690399 Fax: 31-416-690340</td>
</tr>
<tr>
<td>Norway - Trondheim</td>
<td>Tel: 47-72864388</td>
</tr>
<tr>
<td>Poland - Warsaw</td>
<td>Tel: 48-22-3325737</td>
</tr>
<tr>
<td>Romania - Bucharest</td>
<td>Tel: 40-21-407-87-50</td>
</tr>
<tr>
<td>Spain - Madrid</td>
<td>Tel: 34-91-708-08-90 Fax: 34-91-708-08-91</td>
</tr>
<tr>
<td>Sweden - Gothenberg</td>
<td>Tel: 46-31-704-60-40</td>
</tr>
<tr>
<td>Sweden - Stockholm</td>
<td>Tel: 46-8-5090-4654</td>
</tr>
<tr>
<td>UK - Wokingham</td>
<td>Tel: 44-118-921-5800 Fax: 44-118-921-5820</td>
</tr>
</tbody>
</table>